
 

 Introducing Microsoft Word 2003 
Microsoft Word is a powerful and spontaneous word processor. MS Office brings new revolution in 

documentation. Gone are the days of typewriter. Using word you can create a document by using various 

fonts and styles. You can also add graphics and pictures in your document. MS Words allows saving a 

document for future use. You can also take print of your document. MS Office provides fully GUI 

environment that makes easy to use it. The following are the elements of MS Word: 

 

 Title Bar 
Is located at the top of the window and displays the name of the document which is active. 

 

 Minimize Button 
Is located on the upper right corner of the window. It is the first button of existing three buttons. 

 

 Maximize/Restore 
Is also located on the upper right corner of the window. It is the second button of existing three buttons. It 

basically changes the size of the window.  

 

 Document Close Button 

Is located on the upper right corner of the window. It is the third button of existing three buttons. It is 

basically used for closing the document on window. 

 

 Menu Bar 
Is the list of main menu choices located below the title bar. 

 

 Standard Tool Bar 
Provides button for commonly used commands, which are located below the menu bar. 

 

 Formatting Tool Bar 
Provides buttons which are most commonly used for formatting commands, and located below standard 

toolbar. 

 

 Rulers 
Displays information about the left margin, right margin, top and bottom margins, and it also allows 

horizontal and vertical alignment of the text in a document.  

 

 Scroll Bar 
Allows scrolling the document up and down or from left to right. There are two types of scroll bar: vertical 
and horizontal. 
 

 Status Bar 
Displays information about the active document, such as current line number, column number or page 

number. It is located across the bottom of the application window. 
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 Text Area 
Is the area where you enter your text document is referred as Text Area.  
 

 To create a new Microsoft Word 2003 document: 
 Click Start to display Start menu. 

 Select Programs   Microsoft Office  Microsoft Office Word 2003   to open Microsoft Word window.  

 Select File  New or press Ctrl + N to open a new document. 

 Place the insertion point at the location where you want to type the text. 

 Enter the appropriate text. 

 Press the Enter key to end a short line or a paragraph and to create a blank line. 

 Press the Tab key to move the insertion point "1/2" to right. 

 Press the Delete key to remove the character or space immediately to the right of the insertion point. 

 Press the Backspace key to delete the character or space immediately to the left of the insertion point. 

 

 Saving and Opening a Document 
MS Word allows saving document permanently on any location of hard disk for future use. Word enables the 

Save or Save As commands that allow saving a document. The Save As command can be used in three cases, 

these are: To save a document for the first time, to save a document with a new/another name and to save a 

document at a different location. The Save command allows you to save a document with its current name 

in its current location. The Save commands updates a saved document. 

 

 The following are the steps to use the Save command: 
 Click File  Save 

   Or 
 Click Save on the Standard toolbar. 

   Or 
 Press Ctrl + S shortcut key. 

 

 To save a new document you need to apply the following steps: 
 Click File  Save As to display the Save As dialog box. 

 Select the appropriate location where the document needs to be saved by selecting a folder from the 

Save In drop - down list. 

 In the File name text box, type the name of the file and click Save. MS Word enables to open saved 

document easily. When you open a file, Microsoft Word places a copy of the file in an active document 

window. To open a document: 

 Select File  Open or Press Ctrl + 0 key or click Open to display the Open dialog box. 

 Select the appropriate location where you want to save a file in the look in drop - down list. 

 Select the document that is to be opened and click Open. 

 

 Making a Toolbar Visible or Invisible 
MS Word allows setting Word environment according to your requirements. You can make toolbar visible or 

invisible according to your requirements. To make the toolbar visible: 



 

Right click menu bar to open the popup menu. This popup menu contains a large list of tool bar, such as 

Standard, Formatting, Auto Text, Drawing, Forms, Frame and Tables and Borders. Select the appropriate tool 

bar by clicking popup menu. While clicking the selected tool bar will become visible immediately. 

If you want to make toolbar invisible, you just need to right click menu bar and click selected toolbar. The 

selected tool bar is checked from the list and toolbar will become invisible on the screen immediately.  

 

 
 

 
You can open the new document by file menu or click new or by using short cut key. Which one of the 

following short cut keys allows to open a new document? 

(A) Ctrl + O                           (B) Ctrl +N 

(C) Ctrl + S                             (D) Ctrl +P 

(E) None of these 

 

Answer: (B) 
 

Explanation 
Correct Option: 
(B) While pressing Ctrl + N short cut key it opens a new document. 

Incorrect Options: 
(A) While pressing Ctrl + O short cut key it displays Open dialog box. 
(C) While pressing Ctrl + S short cut key it saves your opened document. 
(D) While pressing Ctrl + P short cut key it generates printout of your document. 

 

 
MS word contains number of toolbars such Standard toolbar. Which of the following tool bars exist in 
Word 2003?  
(A) Visual Basic    (B) Wed  
(C) Web Tool    (D) All of these 
(E) None of these  
 
Answer: (D) 
Explanation 
Correct Option: 
(D) Visual Basic: Web and Web Tool toolbars exist in Word 2003  
Incorrect Options: 
Rest of the options in incorrect. 

 

 
Hary wants to open Email toolbar. Which one of the following steps he should perform to open Email 
toolbar  

(A) Chick Insert  Task Pane 

(B) Click View  Task Pane  
(C) Right click on menu bar open the popup menu and click Email     
(D) All of these  
(E)  None of these  



 

 
Answer: (C) 
 
Explanation 

Correct Options:  

(c)  To make the toolbar visible: Right chick menu bar to open the popup menu. This popup menu contains a 

large list of tool bar Select the appropriate tool bar by clicking popup menu, such as task Pane. 

Incorrect Options: 

Rest of the options is incorrect  

 

 Changing Page Setup 
Word 2003 enables Page Setup dialog box that allows setting document according to user requirement. Page 

Setup dialog box includes page margins and page setting. The blank spaces around the edges of the page are 

called page margins. A user can set your page margins according to insert text and graphics. You can also set 

some items in the margins, such as page number, header and footer. 

 

 To set the page margins: 
 Select File  Page Setup to open Page Setup dialog box, as shown in 

the following figure: (See Figure. 9.5.1) 

 Click Margins tab. 

 Set the margins and orientation, such as landscape. 

 Click OK. 

 

Word 2003 automatically inserts section breaks (section break: A mark you 

insert to show the end of a section. A section break stores the section 

formatting elements, such as the margins, page orientation, headers and 

footers, and sequence of page numbers, before and after the pages with 

the new paper size. You can also set paper size according to your 

requirements. 

 

 To change the paper size: 
 Select File  Page Setup to open Page Setup dialog box. 

 Click Paper tab and select a paper size, as shown in the following figure  

 

 Using Word Help 
Sometime while working on Word you face problem to perform particular steps. Does not worry, Word 

enables Microsoft Office Word Help that gives the answer of your queries. You can takes advantage of help 

when you feel difficult to do any steps Using Help user you can use all the basic and advance features of 

Word 2003 in your document. 

  



 

 

 To open Word Help: 
Select Help  Microsoft Office Word Help to open the Word Help dialog 

box, as shown in the following figure: (See Figure. 9.5.2) 

 

Or 

 

Press F1 key.  

Type the search item in Search for text box and click arrow. Help displays all 

related information on your screen.  

 

 Making Document Error Free 
Using spelling and grammar checker you can make your document grammatically correct. The spelling and 

grammar checker can be executed to check the spellings and grammar in the whole document. By default, 

Word checks spelling and grammar as the text is being typed in the document. Wavy red underlines indicate 

possible spelling errors. Wavy green underlines indicate every possible grammatical issue. 

 

 To start the spelling and grammar checker: 
 Select Tools  Spelling and Grammar to display the Spelling and Grammar dialog box, as shown in the 

following figure: (See Figure. 9.5.3) 

 Click Ignore Once to ignore the spelling mistake or Change button to change the word with the 

suggested spelling. 

 After completing the spelling and grammar checking in the whole document, a message box appears 

"spelling and grammar check is complete". 

 Click OK. 

 

 Changing Appearance of Text 
Lina's class teacher gives an assignment to develop a greeting card using various font and size. She also 

wants to convert some text in italic. How will she do it? Actually Word has the features to change the 

document text according to the requirements. Lina can set appearance of her document text by applying 

font, font size, bold and underline. 

 

 To apply font and font size, she will perform the following steps: 
 Select the text in the document and click Format  Font to open the Font dialog box. 

 To set the font, select the required font from the Font list. 

 To set the font style, select the required font style from the Font style list, 

 To set the font size, select the required font size from the Size list. 

 To set the font colour, select the required font colour from the Font colour drop-down list. 

 The preview of the text can be seen in the Preview section. 

 Click OK to close the Font dialog box and apply the selected formatting to the selected text. (See Figure. 

9.5.4) 

  



 

 

 MS Word also enables the following alternative methods that she can used to apply 

font and font size: 
 Click Font list on the formatting toolbar to select the font, such as Times New Roman. 

 Click Font Size list on the formatting toolbar to select the size of the font, such as 11. 

 Click Font Colour list to define the colour of the selected text. 

 

 To make a particular text bold: 
 Select text in the document 

 Click Bold or press Ctrl + B key 

 

 To underline a particular text: 
 Select text in the document 

 Click Underline or press Ctrl + u key 

 

 To apply the Italic on a particular text: 
 Select text in the document 

 Click Italic or press Ctrl + I key 

 

 To apply a particular effect on the text: 
Select the check box for the particular effect such as shadow from the Effects section. 

 

 Paragraph Level Formatting 
MS Word enables paragraph formatting that includes text alignment, setting margins and line spacing. While 

applying formatting it affects the entire paragraph even if a single word is selected or the insertion point is 

placed in the paragraph. To format a paragraph: 

 Select the paragraph/paragraphs to which the formatting has to be applied. 

 Select Format  Paragraph to display the Paragraph dialog box. 

 In the General section, set the alignment of the paragraph from the Alignment drop-down list. 

 In the Indentation section, set the left, right and special indents from Left, Right and Special drop-down 

list. 

 

 MS Word also enables the following alternative methods to 

align the paragraph: 
 Click Align Left in the formatting toolbar for left aligning the text. 

 Click Center in the formatting toolbar for center aligning the text. 

 Click Align Right in the formatting toolbar for right aligning the text. 

 Click Justify in the formatting toolbar for justifying alignment of the text. 

 Set the spacing before and after the paragraph from the before and after 

drop-down list. The spacing between each line can be set by selecting a 

value from the Line spacing drop - down list. Click OK to apply the 

formatting. (See Figure. 9.5.5) 



 

 

 
 

 
Word 2003 allows setting page setup according to your need. To change the page setup you need to open 

the Page setup dialog box. Which one of the following is the correct step to open page Setup dialog box? 

(A) Select File  Page Setup 

(B) Select Format  Page Setup 

(C) Select Insert  Page Setup 

(D) Select File Print  Page Setup 

(E) None of these 

 
Answer: (A) 
Explanation  
Correct Option: 

(A) Select File   Page Setup to open page setup dialog box. 
Incorrect Options: 
Rest of the options is incorrect. 

 

 
Which one of the following short cut keys allows opening of Help? 

(A) F1                               (B) F2 

(C) Ctrl + S                           (D) F3 

(E) None of these 

 

Answer: (A) 

Explanation 

Correct Option: 
(A) While pressing F1 key it opens word help. 
Incorrect Options: 
Rest of the options is incorrect. 

 

 Printing Document 
To print the document you need to perform the following steps: 

 Click File menu and select print option to open print dialog box, as 

shown in the following  figure: (See Figure. 9.5.6) 

OR 

 Click Printer icon on the Standard toolbar. 

 In the Copies option, type the number of copies that is to be 

printed. 

 Click OK. 

Note: Ctrl + P can be used to print the entire file.  
 



 

 Words Counting 
MS Word allows you to count number of pages, words, character (no space), 

character (space), paragraph, and lines in a document. To apply word count: (See 

Figure. 9.5.7) Select Tools   Word Count to display the Word Count Dialog box.  

The Word Count Dialog box display all information including number of page, 

words, character (no space), character (space), paragraph and lines in a 

document. 

 

 Search and Replace Text 
MS Word provides the facility to search or match specific text in the document. You can also replace the 

searched text with other text. This facility is very useful because it minimizes the time and effort required for 

searching the text in the document.  

 

 To open the Find & Replace dialog box: 
 Select Edit  Find or Replace menu option or press Ctrl   F short cut 

key, as shown in the following figure: (See Figure. 9.5.8) 

 Enter the word or text, which you want to search for in the Find 

what list box and click Replace tab. 

 Enter the word that you want to replace in Replace with list box. 

 Click Find Next for finding specified word. This will highlight the 

word in the whole document. 

 Click Replace All for replacement of word in the whole document or click replace to replace the current 

highlighted word. 

 

 Inserting an Image using Clipart 
MS Word enables you to insert image or shape in a document. Clipart 

is a library that provides number of picture. You can directly insert 

those images in your document. To insert an image: (See Figure. 9.5.9) 

 Locate the cursor where you want to insert an image. 

 Go to the menu bar and select Insert  Picture  Clipart, as 

shown in the following figure: 

 Select the appropriate picture and right-click to open pop menu. 

 Click Insert.  

 

 Kerning 
Word 2003 enables to adjust Kerning in your document. Basically it is a process of moving letters closer 

together, in an effort to overcome the illusion of too much space between letters. It makes the text both 

more appealing and readable. In Word, kerning can be adjusted either automatically or manually. 

 

 To change kerning automatically: 
 Select the text and right click to open the popup menu. 

 Click Font to open the Font dialog box, as shown in the following figure: (See Figure. 9.5.10) 

 Click Character Spacing tab and adjust the character spacing and positions. 



 

 Select the Kerning for fonts check box, as shown in the following figure: 

 Click OK. 

 

 Working with WordArt 
Word Art is an excellent feature of Word 2003. Basically it is an auto shape toolbar in Microsoft Word 2003 

that allows creating a variety of three-dimensional word shapes. You can change the text, determine text 

wrapping points and even modify the orientation of the text.  

 

 To insert the word art: 
 Select the area of the document where you want to place the word art. 

 Click anywhere inside of the document to select a location for the 

placement of the word art. 

 Click Insert WordArt to open the WordArt gallery, as shown in the following 

figure: 

 Select the desired word art design. 

 Click Ok to open the Edit WordArt Text dialog box, as shown in the 

following figure; 

 Type the text and set the font and size.  

 Click OK to apply all effects. 

 
 

 Creating Tables 
Some time you need to represent information in tabular forms. Word 2003 enables the facility to insert a 

table in word document easily. You can apply various functions. such as insert and delete data. You can also 

increase or decrease number of columns and rows according to your requirements. 

 

 To insert a table in word document: 
 Place the cursor where you want to place the table. 

 Select Table  Insert  Table to display the Insert Table dialog box, as shown in the following figure: 

 Set the number of columns in the Number of columns text box. 

 Set the number of rows in the Number of rows text box. 

 To close the Insert Table dialog box Click OK. 

 A table with the defined number of rows and columns will get inserted in the document. 

 

You can move the cursor in table by tab key or arrow key or click in the appropriate cell. After inserting table 

in a document, it can be modified as it required. The columns and rows can be added to the table or deleted 

from the table.  

 

 To add a row: 
 Where the row is to be added above or below in the cell place the insertion point there itself. 

 Select Table  Insert  Rows Below or Rows Above.  

 
 



 

 To add column: 
 Where a new column is to be added place the insertion point in the column beside that place. 

 Select Table  Insert  Columns to the Right or Columns to the Left. 

 

 To delete rows: 
 The row to be deleted place the insertion point there. 

 Select Table  Delete  Rows. 

 

 To delete columns: 
 The column to be deleted place the insertion point there. 

 Select Table  Delete  Columns. 

 

 Thesaurus 
Thesaurus allows looking word in another language. If your document is written in French and you want to 

see the synonyms in other language of that word use thesaurus. 

 

 To use thesaurus: 
 Click Research on the Tools menu to open the research dialog box. 

 In the Search for list, select Thesaurus. 

 Press ALT and click the word you want to look up. 

 Results will appear in the Research task pane. 

 

 
 You can save your word document in XML format. 

 

 
 WordArt: Is an auto shape toolbar in Microsoft Word 2003 that allows creating variety of three-

dimensional word shapes to add to the document 

 Thesaurus: Allows looking word in another language. 

 

 
 MS Word allows saving document permanently on any location of hard disk for future use. 

 Word 2003 enables Page Setup dialog box that allows setting document according to user requirement. 

 By default, Word checks spelling and grammar as the text is being typed in the document. 

 MS Word allows you to count number of pages, words, character (no Space), character (space), 

paragraph and lines in a document. 

 Kerning makes the text both more appealing and readable. 

 Word 2003 enables the facility to insert a table in word document easily. 

 Wavy red underlines indicate possible spelling errors. 



 

 Wavy green underlines indicate every possible grammatical issue. 

 Clipart is a library that provides number of picture. 

 

 Abbreviations  
MS  ………………….. Microsoft Office  
WAN ………………….. Wide Area Network 

  



 

 

 
 

 
     Font list is available on the ....................... 

 (A) Toolbar                          (B) Formatting toolbar 

 (C) Menu bar                        (D) All of these 

 (E) None of these 

 

 

    MS Word allows you to count ........... 

 (A) Number of pages                  

(B) Character (no space) 

 (C) Character (space)                  

(D) All of these 

 (E) None of these 

 

 

ClipArt is a library that provides number of picture. Which one of the following is the correct  step to 

open clipart? 

 (A) Insert  Clip Art 

 (B) Insert  Picture  Clip Art 

 (C) Tools  Picture  Clip Art 

 (D) Tools  Clip Art 

 (E) None of these 

 

 

    ____ is located at the top of the window and displays the name of the document. 

 (A) Title bar                         (B) Menu bar 

 (C) Restore button                    (D) All of these 

 (E) None of these 

 

 

    Given below the two statements. Which one of the following is correct? 

 Statement A: MS Word allows setting Word environment according to your requirements. 

Statement B: MS Word does not allow setting Word environment according to your requirements. 

 (A) Statement A is correct 

 (B) Statement B is correct 

 (C) Both statement A and B are correct 

 (D) Both statement A and B are incorrect 

 (E) Both statement A and B are partially correct 



 

 

 

    Steve while working on Word faces problem to perform particular steps. Which one of the following 

options of Microsoft Office Word gives the answer of his queries? 

 (A) Edit                               (B) Insert 

 (C) Tool                              (D) Help 

 (E) None of these 

 

 

    If you need to change the typeface of a document, which menu will you choose? 

 (A) Edit                              (B) View 

 (C) Format                           (D) Tools 

 (E) None of these 

 

 

    Which one of the following is not a font style? 

 (A) Bold 

 (B) Italics 

 (C) Regular 

 (D) Superscript 

 (E) None of these 

 

 

    How can you break the current column and start a new column immediately? 

 (A) Press Ctrl + Shift + Enter           (B) Press Alt + Enter 

 (C) Press Ctrl + Enter                   (D) Press Alt + Shift + Enter 

 (E) None of these 

 

 

  You wished to justify text over the height of paper, which option will you choose 

 (A) Page Setup from File menu 

 (B) Paragraph from Format menu 

 (C) From formatting toolbar 

 (D) Font from Format menu 

 (E) None of these 

 

 

 

  



 

 

 
 

Explanation for Selected Questions  
 

 

 Correct Option: 
 (B) Font list is available on the formatting tool bar. 

 Incorrect Options: 

 Rest of the options is incorrect. 

 

 

 Correct Option: 
(D) MS Word allows you to count number of pages, words, character (no space), character (space), 

paragraph and lines in a document 

Incorrect Options: 

 Rest of the options is incorrect. 

 

 

 Correct Option: 
 (B) Insert  Picture  Clipart allows you to open clipart. 

 Incorrect Options: 

 Rest of the options is incorrect. 

 

 

 Correct Option: 
 Title bar is located at the top of the window and displays the name of the document. Therefore, option (A) is 

correct and rest of the options is incorrect.   

Incorrect Options: 

 Rest of the options is incorrect. 

 

 

 Correct Option:                              
MS Word allows setting Word environment according to your requirements. Therefore, option (A) is correct 

and rest of the options is incorrect. 

Incorrect Options: 

 Rest of the options is incorrect. 

 

 



 

 

 

 Correct Option: 
Sometime while working on Word you face problem to perform particular steps. Word enables Microsoft 

Office Word Help that gives the answer of your queries. Therefore, option (D) is correct and rest of the 

options is incorrect. 

Incorrect Options: 

 Rest of the options is incorrect. 

 

 

 Correct Option: 
 To change the typeface of a document you will choose tools menu. Therefore, option (C) is correct and rest 

of the options is incorrect. 

 Incorrect Options: 

 Rest of the options is incorrect. 

 

 

 Correct Option: 
Super script is not a font style. Therefore, option (D) is correct and rest of the options is incorrect 

Incorrect Options: 

Rest of the options is incorrect  

 

 

 Correct Option: 
Press Ctrl + Shift + Enter is the correct steps to break the current column and start a new column 

immediately. Therefore, option (D) is correct and rest of the options is incorrect  

 Incorrect Options: 

 Rest of the options is incorrect. 

 

 

 Correct Option: 
 Page Setup form File is used to Justify text the height of paper Therefore , option (A) is correct and rest of 

the options is in incorrect.  

 Incorrect Options: 

 Rest of options is incorrect. 

 

 
 
 

ANSWERS 

1. B 2. D 3. B 4. A 5. A 6. D 7. C 8. D 9. D 10. A 

 
 


